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Abstract

The analysis of exercise electrocardiogram (ECG) is based on the alteration of the measured variables in the
detection of coronary artery disease (CAD). In its existing form the analysis of the exercise ECG is laborious and
requires much time. The temporal analysis of the ECG variable and the comparison between different phases of the
exercise test is difficult and time consuming, especially the simultaneous examination of the variables over several
leads. In this article we present a computer program, ECG Variable Cine, for the visualization of the temporal
changes of values of exercise ECG variables over the selected ECG lead system. The program includes the stationary
3-D presentation for the variables’ alteration simultaneously in all selected leads over the time of exercise test. In
addition, the program determines two parameters; the average value of the variable over the selected leads at every
sample moment, and the chronotropic index, a parameter that indicates heart rate response to exercise. According to
the results the average value of ST-segment deviation at the end of the exercise over the leads and chronotropic index
are clinically more competent than the maximum value of ST-segment depression in the detection of CAD. © 2000
Elsevier Science Ireland Ltd. All rights reserved.
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1. Introduction

Coronary artery disease (CAD) is still the main
cause of death in developed countries. Exercise

test is the first clinical examination when CAD is
suspected. Electrocardiogram (ECG) is the most
important factor during the exercise test. The
exercise ECG test is simple, cheap and a relatively
accurate method. In CAD detection, the main
interest during the exercise ECG test is focused on
the ST-segment alterations during the exercise and
recovery phases [1]. Also the changes in the R-
[2,3] and T-waves [4,5] have shown to have an
importance when detecting the CAD based on the
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exercise ECG. In a conventional presentation the
signals and the variables of the ECG leads are
temporally and spatially showed separately and the
printed report usually contains a large number of
pages. Thus the comparisons in the alteration of the
variables between the several leads and between the
different stages are difficult, confusing and partic-
ularly time consuming. If the alteration of an ECG
variable is presented as a function of time during
exercise test the diagram includes only one lead at
a time. However, it is possible to present the values
of ECG variables over several leads simultaneously
next to each other and chronologically from the
beginning to the end of the exercise test. Then the
comparison and the comprehensive examination of
the variable alteration at the specific moment of an
exercise test between the used leads and temporally
throughout the whole exercise test would be easier,
faster and allow more detailed analysis of the
exercise ECG variables.

In this study we have constructed a computer
program, ECG Variable Cine, for the continuous
presentation of the ECG variable simultaneously in
all measured ECG leads during the exercise test. In
addition to the Cine mode, the program includes
a display mode for stationary pictures of variable
alterations during the whole exercise test at the
same time in all leads, the 3-D presentation mode.
Furthermore the program determines and displays
a novel parameter, average (Ave), which is an
average value of the variable over the selected leads
at every sample moment, and a parameter that
indicates heart rate response to exercise, the
chronotropic index [6–8] (CRI). The CRI is as-
sessed by calculating the ratio of maximum heart
rate reserve achieved to the age-predicted maxi-
mum heart rate reserve (i.e. it describes the percent-
age of the heart rate reserve used). The values of
these parameters can be saved to separated files for
further processing (e.g. scientific research).

2. Program description

The program is designed for the PC with Micro-
soft Windows version 3.1 or later. It was imple-
mented by using Borland C+ + 4.50 for Windows
and basic Windows libraries.

2.1. Input format for data

Observing the versatile utilization and compati-
bility with other programs the input format used
for ECG Variable Cine is identical as in the
previously published computer program [9]. The
input data format should be ASCII file with the
extension sth. Before the measured patient data
the file should include the global header that is
common to all data of individual patient(s). The
first three rows of the global header include the
identification code for the program, the name of
the variable used and the number and names of
descriptive characteristics of the patients (the
maximum number is eight). The number of ECG
leads, the duration of each exercise stage in sec-
onds, the sampling interval in seconds both for
the exercise phase and for the recovery phase, and
the names of the leads are also indicated in the
global header. The maximum number of ECG
leads is 20.

Each patient data begins with a patient header
including the identification code of the patient,
the total number of samples and the ordinal num-
ber of the end-exercise sample. In addition to
these, the patient header can include descriptive
characteristics of the patient (such as age, weight,
height, medication, symptom, etc.), which were
defined in the global header. The measured values
of the variable are presented after the patient
header each sample in its own row. Each data row
starts with heart rate in beats/min, followed by
variable values (number of columns will be the
same as the number of ECG leads in the global
header.). The sth-file can contain data of several
patients (number of patients is not limited by
program), but there should be two empty rows
between the data of consecutive patients.

2.2. Program properties

2.2.1. Cine presentation
According to the initial settings the program

starts with the main window in the Cine mode (Fig.
1). The order of the leads is the same as those in
the global header of sth-file and the scale is
automatic, from minimum to maximum for each
patient. During the presentation the exercise
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and recovery phases are distinguished by different
colors. The heart rate values through out the
exercise test are shown as a column with a changing
grade level in the right-hand side of the main
window. The horizontal lines between the variable
diagram and the heart rate column present the
average values of the variable over the leads (de-
noted with x̄). The control buttons for the Cine
presentation are located in the lower left-hand
margin of the main window. Pressing the Play
button the Cine presentation starts and the consec-
utive samples appear in the main diagram window
at the fixed interval. The value of the presentation
speed (frame frequency) is indicated on the right-

hand side of the control buttons. The speed can be
increased or decreased from 0.1 to 1.0 s using the
small upper/lower arrow buttons adjacent to the
speed value. The double arrow buttons (BB or
\\ ) allow the user to go forward or backward
frame by frame. The double arrow buttons with
vertical line (�BB or \\ �) enable a direct shift
to the beginning or to the end of the exercise test.
The Cine presentation can be halted at any time
with the Stop button. Selecting the Play button
again the Cine presentation proceeds from the
halted situation. The displayed parameters and the
different features of the presentation can be selected
from Edit/Settings and View menus.

Fig. 1. ECG Variable Cine presentation. Control buttons are located in the lower left-hand margin. Exercise and recovery phases
are distinguished by different color and the previous values are presented as a shadow on a screen.
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Fig. 2. 3-D stationary picture of the ECG Variable Cine presentation. From the lower left-hand buttons user can select four different
observation angles. The continuous curve adjacent to the last ECG lead (right-hand) indicates the heart rate values during the
exercise test.

2.2.2. 3-D presentation
The change to the 3-D presentation mode takes

place when selecting the 3-D Graphics option
from the View menu. Fig. 2 presents the 3-D
Graphics window using the initial settings of the
3-D presentation mode with the optional heart
rate curve. In the 3-D presentation mode all the
measured values from the beginning to the end of
exercise are presented with a stationary picture
having all the selected leads in the same graphics.
It is possible to examine the 3-D presentation
from four different observation angles. The con-
trol buttons for the different observation angles
are located in the lower left-hand margin of the

main window. The 3-D diagram includes three
heart rate values, those at the beginning, at the
end and the maximum heart rate value achieved
during the exercise test, next to the time axis. In
addition all the measured heart rate values can be
presented as a continuous curve adjacent to the
last ECG lead. As in the Cine mode the values of
the exercise and recovery phases are indicated
with different colors. Furthermore, the time axis
or lead order can be presented in the reverse order
in the 3-D presentation mode. In addition to the
plain 3-D Graphics, the 3-D presentation mode
includes the 3-D Mesh option when the data is
presented as the net-like graphics (Fig. 3).
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2.2.3. Menus and features of the program
Three user menus, File, Edit, and View, are

located in the upper left-hand corner of the main
program window. In addition to Open, Print and
Exit commands, the file menu includes the Save
Ave and CRI command that allows the user
to save the values of average and chronotropic
index determined by the program into the sepa-
rated files. The average value is determined from
all the leads (initial setting) or from the selected
leads. The CRI is defined by formula [(HRstage

−HRrest)/(age-predicted HR−HRrest)] where HR
refers to heart rate, stage refers to any given stage
of exercise and age-predicted HR is deter-
mined using the formula selected from the Set-
tings. The maximum achieved heart rate value

and the heart rate value at the beginning of the
exercise test were used as HRstage and HRrest,
respectively.

The Edit menu includes Copy and Settings
commands. By selecting the Settings the user can
(a) change the colors and the limits of the axes for
the ECG variable, (b) select the displayed leads
and define their order, (c) choose whether the
age-predicted maximum heart rate is determined
and displayed and (d) select the displayed descrip-
tive characteristics of the patient from the sepa-
rate windows (Fig. 4). The Age-Predicted HR
option requires that the value for age has been
given in the patient header (the heart rate scale in
graphics will be adjusted with the maximum value
determined by chosen formula).

Fig. 3. 3-D Graphics as a mesh presentation and with a continuous heart rate curve. Lower left-hand window is patient menu
(identification codes for the patients) adjacent to which is the lead menu (the names of the leads). Two data boxes display the
selected descriptive characteristics of the patient and duration of the exercise test.
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Fig. 4. Four different setup windows for the selection and changing of the displayed variables.

The View menu includes the tools for the Cine
and the 3-D presentations of the variables. From
that menu user can select two different layouts for
the program window. One option displays only
the main diagram window with operation buttons
on the screen (as in Figs. 1 and 2) and the other
option displays two supplementary windows with
the patient and the lead menus and two data
boxes with the descriptive characteristics of the
patient and the duration of the exercise test below
the diagram window (as in Fig. 3). If the latter
option is selected the control buttons are located

in the separated movable box, which floats over
the main diagram window. From the View menu
the user can choose the Autoscale option when
the axes are scaled from the minimum to maxi-
mum value of the variable. The Invert Variable
option inverts the values of variable (changes the
sign). In the Cine presentation each variable value
and heart rate presented are possible to leave on
the screen as a shadow, different color (as in Fig.
1). The values at the beginning and at the end of
exercise are also able to present with different
colors. Furthermore, the average values and the
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CRI determined by the program are possible to
display in the Cine window. The changing to the
3-D presentation mode takes place also from the
View menu.

3. Study population determined parameters

3.1. Material and methods

The importance of the average value defined
from different lead sets and the CRI was evalu-
ated in the detection of the CAD using a study
population comprised of 201 male patients, 101
with CAD and 100 clinically normal. The ST-
segment depression during exercise test was used
as an ischemic response. Computer-determined
ST-segments amplitudes at a point 60 ms after
the J-junction were measured to the nearest 10
mV considering the end of PR-segment as the
isoelectric line. A detailed description of the pa-

tient material is presented in our previous study
[10]. The averages of ST-segment alteration were
defined for each patient from all 12 leads
(Ave12), from six chest leads (Ave6V), and from
six limb leads (Ave6L) at the end of exercise.
The end-exercise maximum values of ST-segment
depression over the selected lead systems
(Max12, Max6V, and Max6L) were used in ref-
erence variables. The CRI was determined using
the formula given in Section 2.2.3 where the age-
predicted maximum heart rate was defined by
(220-age). The sensitivity values at fixed 90% spe-
cificity and the area under the receiver operating
characteristics (ROC) analysis were used when
comparing the diagnostic capabilities of the aver-
age, maximum and CRI variables. The statistical
differences of the sensitivity values at the fixed
90% specificity were compared using McNemar’s
modification of the chi-square method for paired
proportions and differences between the areas
under two ROC curves were compared using
non-parametric analysis of correlated ROC
curves [11] with a routine written by Vida [12]
(version 2.5).

3.2. Results

Fig. 5 presents the ROC curves for the CRI,
Ave12 and Max12. The areas under the ROC
curves for the CRI, Ave12 and Max12 were 88.7,
85.8 and 79.1%, respectively. The CRI and
Ave12 had a significantly higher area under the
ROC curve than the Max12 (P=0.0176 and
P=0.0290, respectively), but the difference be-
tween CRI and Ave12 was not significant (P=
0.3560). The sensitivity values at the 90%
specificity were 67.5, 59.4 and 49.4% for the
CRI, Ave12 and Max12, respectively. Statistical
comparison showed significant difference only
between the CRI and Max12 (P=0.0271). The
areas under the ROC for the Ave6V and Max6V
(i.e. from chest leads) were 83.3% and 81.6%
(P=0.5605) and for the Ave6L and Max6L (i.e.
from limb leads) were 85.3 and 74.9% (P=
0.0004). The sensitivity values at the 90% specifi-
city were 56.4 and 55.5% for the Ave6V and
Max6V (P=0.755) and 58.4 and 37.8% for the
Ave6L and Max6L (P=0.0005).

Fig. 5. ROC curve for the chronotropic index (CRI), average
of end-exercise ST-segment alteration from all 12 leads
(Ave12) and maximum value of end-exercise ST-segment de-
pression from all 12 leads (Max12). The nearest partition
values at 90, 80 and 70% specificity are indicated for each
variable. The units for Ave and Max are mV, whereas the CRI
is unitless.
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4. Discussion

The ECG Variable Cine program was developed
for the analysis of the ECG variables gathered
during an exercise test. The program enables the
presentation of discrete ECG variables as a contin-
uous cine presentation over measurement interval.
In addition to Cine presentation the program also
includes fast and easy observation of the ECG
variable as a stationary picture, 3-D presentation.
The Cine and 3-D presentations facilitate observa-
tion of the ECG variable throughout the entire
exercise test and over the selected lead system at a
glance enabling a faster and more detailed analysis
of the exercise ECG. The user can define the
number and order of the displayed leads. Therefore
the user can focus more effectively on the leads
desired and can compare the values between the
leads as well as the temporal changes in each lead.

In addition to visualization the program deter-
mines two diagnostic parameters, the average value
of the ECG variable over the selected leads and the
chronotropic index, CRI. The summing method
over all 12 leads, similar to the average method, has
been previously used in the analysis of the ST-seg-
ment alteration when evaluating patients with my-
ocardial infarction during and after percuntaneous
transluminal coronary angioplasty (PTCA) [13–
15]. However, the crucial difference of our method
is that in the summing method the absolute values
(values without sign) of ST-segment deviation were
summed over 12 leads. The CRI has been shown
to improve the performance of the traditional and
heart rate-adjusted ST-segment depression criteria
for identification of CAD [8] and to be predictive
of increased coronary heart disease incidence [6].
The program enables a saving of the values of
average and CRI into separate files, which makes
it a very useful tool for scientific researches.

Due to the Windows based implementation the
ECG Variable Cine program is easy to use and easy
to implement to PC based ECG apparatus and
analyzers.

5. Conclusion

The ECG Variable Cine program provides a new

method for the examination of the ECG variables
gathered during exercise test over the ECG leads
and over the duration of exercise test. According
to the results two diagnostic parameters, the aver-
age value of ST-segment deviation at end of exer-
cise over the selected leads and the CRI, determined
by the program are clinically more competent than
the traditional maximum value of ST-segment
depression in the detection of CAD.
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